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Introduction  

 

Ruby In Steel  is a Ruby IDE for Microsoft Visual Studio  2008 or 2005. Developed by 

SapphireSteel Software, it is available in two principal editions: 

 

Ruby In Steel Developer  

 

Aimed at professional programmers, Ruby In Steel Developer  is a powerful editing and 

debugging environment for Ruby and Ruby On Rails. Its intellige nt inference engine provides 

numerous Ruby IntelliSense features; it includes the ultra -fast 'Cylon' debugger and 

2È××ÏÐÙÌ2ÛÌÌÓɯ2ÖÍÛÞÈÙÌɀÚ unique drag and drop Ruby On Rails design environment, The 

Visual Rails Workbench. 

 

Ruby In Steel Text Edition  

 

Ruby In Steel  Text Edition  provides project management, editing and debugging tools for 

Ruby and Rails development and includes integrated debugging  (but not the fast Cylon 

debugger). (ÛɯÔÈàɯÌÐÛÏÌÙɯÉÌɯÐÕÚÛÈÓÓÌËɯȿÚÛÈÕËÈÓÖÕÌɀɯȹÐÕɯÞÏÐÊÏɯÊÈÚÌɯÐÛɯÈÓÚÖɯÐÕÚÛÈÓÓÚɯÈɯȿ1ÜÉà-ÍÓÈÝÖÙɀɯ

version of Visual Studio 2008) or it may be integrated into an existing version of Visual Studio 

2008 if one is present on your PC. 

 

Other Editions  

 

%ÙÖÔɯÛÐÔÌɯÛÖɯÛÐÔÌȮɯ1ÜÉàɯ(Õɯ2ÛÌÌÓɯÔÈàɯÈÓÚÖɯÉÌɯÔÈËÌɯÈÝÈÐÓÈÉÓÌɯÐÕɯȿ/ÌÙÚÖÕÈÓɀɯÌËÐÛÐÖÕÚ. These 

may offer a subset of the features of one of the editions above. For example, IronRuby In Steel 

ȿ/ÌÙÚÖÕÈÓɯ$ËÐÛÐÖÕɀ contains only  ÛÏÖÚÌɯÍÌÈÛÜÙÌÚɯÕÌÌËÌËɯÛÖɯËÌÝÌÓÖ×ɯ×ÙÖÎÙÈÔÚɯÜÚÐÕÎɯ,ÐÊÙÖÚÖÍÛɀÚɯ

IronRuby for .NET.  Not all the features described in this manual apply  to these editions. 

 

This Manual  

 

This is the official reference manual and user guide to Ruby In Steel. Note that not all the 

features are available in the Text Edition.  
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The Installation Guide  

 

Before installing Ruby In Steel, be sure to read the Installation Guide, Installation 

Instructions.pdf , supplied with the software.  

 

 

To buy or download the latest versions of both the Ruby In Steel software and this 

manual  and to keep up to date with news and tutorials , be sure to visit the 

SapphireSteel web site : 

 http://www.sapphiresteel.com   

 

 

http://www.sapphiresteel.com/
http://www.sapphiresteel.com/
http://www.sapphiresteel.com/
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Installation  

 

Requirements: You must have Visual Studio 2008 or 2005 (Standard edition or higher), 

Windows XP (service pack 2) or Vista and a Ruby interpreter ( ruby.exe). Alternatively, y ou 

may optionally install a single -language (Ruby) version of Visual Studio 2008 at no additional 

cost ÜÚÐÕÎɯÖÜÙɯȿ ÓÓ-in-ÖÕÌɀɯÐÕÚÛÈÓÓÌÙ.  

 

 

How To Install Ruby In Steel  

 

IMPORTANT ! If you need to install a free Ruby language edition of Visual Studio 

2008, a Ruby interpreter, the Rails framework, the MySQL database or any 

ÊÖÔÉÐÕÈÛÐÖÕɯÖÍɯÛÏÌÚÌɯÊÖÔ×ÖÕÌÕÛÚȮɯàÖÜɯÊÈÕɯËÖɯÚÖɯÜÚÐÕÎɯÖÜÙɯȿ ÓÓ-in-ÖÕÌɀɯÐÕÚÛÈÓÓÌÙɯ

available on the Ruby In Steel Download page. 

 

 

The Installation Guide  

 

If you need help choosing which components to install, p lease read the separate Installation 

Guide  (PDF format ) which is supplied with the software.  This explains every step of the 

installation procedure in detail.  

 
 

Quick Install ... 

 

If you have a previous version of Ruby In Steel installed, be sure to remove this first:  

Select Start Menu, then Settings, Control Panel, Add Or Remove Programs. Finally , select the 

Ruby In Steel item and click the Remove button.  

 

Unzip the Ruby In Steel installation archive into a directory of your choice (for example, 

C:\ temp). This directory will now contain the files needed for the installation of Ruby In Steel.  

 

Make sure that Visual Studio is not running when installing (or uninstalling) Ruby In Steel.  
 

 

http://www.sapphiresteel.com/spip?page=download


Ruby In Steel User Guide and Manual  (1.3) ɬ www .sapphiresteel.com ɬ page: 5 

FIRST, INSTALL YOUR KEY 

 

If you have a licensed edition of Ruby In Steel, you should have received or downloaded a 

'key file' with your order. The key file is named key.bin . This must be copied into the same 

directory as Setup.exe. For example, if you unzipped the installation files (including 

Setup.exe) into C:\ temp you must copy key.bin  into C:\ temp before installing Ruby In Steel.  

 

 

If you are installing Ruby In Steel into an existing version of Visual Studio...  

 

First ensure that you have downloaded the appropriate version of the installer (either for 

Visual Studio 2005 or 2008) then follow these steps... 

 

Double-click Setup.exe to begin installation. After a few moments you will see the Ruby In 

Steel Installer Splash screen. Select all the options you wish to install and follow all directions 

throughout the setup process. The Ruby In Steel installer displays this registration di alog: 

 

 

 

In the Registration Dialog, you should enter the following details:  

 

 Registered User Name 

This is the name that the product is licensed to (without quotation marks).  

 Serial Number  

This is the Order number which will have been sent with your order  conformation.  
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You must enter these details EXACTLY (uppercase and lowercase characters, punctuation 

and spaces are significant). Click OK to confirm registration details.  

 

If an error message appears, please verify that you have entered the user name and 

serial number correctly and that the file, key.bin , has been copied into the directory 

containing Setup.exe.  

 

When complete you will see a screen stating 'Installation Comp lete'. Press the Close button 

and you are now ready to load Visual Studio with Ruby In Steel.  

 

 

Checklist On First Using Ruby In Steel  

 

When you load Ruby In Steel for the first time, you should check that the paths to the Ruby 

Interpreter and, optionally,  to your database server(s), are correct: 

 

 See  'Configure Ruby and Database Paths'.  
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Five Minute Guide To Ruby In Steel  

 
IF THIS IS THE FIRST TIME YOU'VE USED RUBY IN STEEL, THIS STEP-BY-STEP WALKTHROUGH WILL EXPLAIN HOW 

TO CREATE AND RUN YOUR FIRST PROGRAM IN A MATTER OF MINUTES... 

 

Create a New Project  

 

You can start a new Ruby In Steel project just as you would start any other Visual Studio 

project. 

 

Select the File menu, then New, then Project. 

 
The New Project Dialog 

 

When the New Project dialog appears, select the Ruby In Steel branch in the left -hand pane. 

For now we shall create a plain vanilla Ruby project so make sure the Ruby Project icon is 

selected in the right hand window.  
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Give the project a name by filling out the Name: field at the bottom of the dialog (for now 

enter the name RubyTest). If you wish, you may click the Browse button to select a directory, 

otherwise you may accept the default location. If you check the 'Create directory for solution' 

button, a new subdirectory will automatically be created for your project. Now click OK. 

 

Projects and Solutions...  

Ruby In Steel organizes Projects in the form of branches in a Solution. A project is a 

group of one or more files in one or more directories. A Solution is a a group of one or 

more projects. You can add new projects by right-clicking the Solution at the top of 

the Solution Explorer and selecting Add, New Project. The Solution Explorer provides a 

convenient way of keeping related files grouped together from one work session to 

the next. For Rails programmers, it also gives you an easy way of working with the 

numerous folders comprising a Rails application.  

 

When you create a new Ruby project, an empty source code file, rubyfile.rb , is added 

automatically. Optionally, you may add more Ruby code files to the Project using the 

Solution Explorer. Let's do that now: right -click the indented Project branch (not the top-level 

Solution itself) and select Add, then -ÌÞɯ(ÛÌÔȱ 

 

When adding a new Ruby file, right -click the indented Project branch and select Add, New Item  

 

 

In the Add New Item dialog, select the Ruby File item (this will create an empty Ruby file) and 

give it the name, test.rb ,  in the field at the bottom of the dial og. Then click Add. 
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Now you are ready to start writing your program.  Enter the following:  

 
def  sayHello (  aName )   

 print (  "Hello, " , aName )   

end  

 
puts (  "What is your name?"  )  

name = gets ()  

sayHello (  name )  

 

Notice that Ruby In Steel automatically color codes the text as you enter it so that reserved 

words such as def  and end are obviously different from method names such as print  or 

sayHello ÈÕËɯÚÛÙÐÕÎÚɯÚÜÊÏɯÈÚɯɁ'ÌÓÓÖɂȭɯ(ÛɯÈÓÚÖɯɅÖÜÛÓÐÕÌÚɅɯàÖÜÙɯÊÖËÌɯÚÖɯÛÏÈÛɯÛÏe body of a method 

such as def sayHello  can be hidden from sight by clicking the minus symbol in the 'button' to 

the left of its name or made visible again by clicking the plus symbol.  

 

Code Collapsing  

Ruby In Steel has advanced 'code collapsing' capabilities. It collapses methods, 

modules, classes, if..else  blocks, case statements, for , while  and until  loops, blocks 

delimited by { and } or by do and end - and more besides... 

 

To run the program , press CTRL+F5. If there is a syntax error a window pops up to tell you. 

Click the error message to locate the problem code in the editor. Fix the error and try again. 

When any syntax errors are fixed, press CTRL+F5 again and your program will run inside an 

interactive integrated console window, seen below the edito r here... 
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Project Management  

 
RUBY IN STEEL LETS YOU CREATE, IMPORT AND MANAGE COMPLEX PROJECT GROUPS COMPRISING NUMEROUS 

FILES AND FOLDERS.  

Create A New Project  

 

Ruby In Steel organizes your programs in the form of one or more projects grouped together 

as a Solution. To make use of all the editing and debugging features, you must create a 

project to which your Ruby files are added.  

How To Create A New Ruby Project  

 

 1. Select the File menu, then New, Project (or simply press CTRL+SHIFT+N). 

 2. In the New Project Dialog select the Ruby In Steel Project type in the left pane. 

 3. Select the Ruby Project icon in the right pane.  

 4. Enter a name for the new project and optionally browse to find an empty directory.  

 5. You may optionally select Create directory for solution. 

 6. Click OK. 

 

Importing and Converting Projects  

 

If you have an existing Ruby or Rails project that you wish to import into Ruby In Steel, you 

may either make a complete new copy of the existing project in a new directory on disk or 

you may convert the project 'in place' (Developer Edition only) by creating a Visual Studio 

Solution in the top -level directory of the original project.  

 

A 'project' may be any group of files and directories on disk. In the case of a Rails 

application, the top -level directory of a project is normally the folder whose name 

identifies the application (e.g. \MyBlog ) and which contains the various Rails 

directories such as \app and \config . When imported into Visual Studio, the files and 

directories will be added into a Visual Studio 'Solution file' and they will then appear 

beneath a Project branch in the Solution Explorer. 
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How To Import A Project  

 

FOLLOW THESE STEPS TO  COPY FILES TO A NEW LOCATION AND IMPORT THEM INTO A VISUAL 

STUDIO SOLUTION ... 

 

 Select the File menu, then New, Project (or simply press CTRL+SHIFT+N). 

 In the New Project Dialog select the Ruby In Steel Project type in the left pane. 

 Select the Import Project icon in the right pane.  

 Enter a name for the new project and optionally browse to find an empty directory.  

 You may optionally select Create directory for solution (this is recommended). 

 Click OK.  

 The Import Project dialog now appears...  

 

 

 Here the first field is the source directory of the Project you wish to import. You can 

click the button to the right of this field to browse and find the directo ry containing 

this project. 

 The second field is the target directory (which you previously chose in the New Project 

dialog) into which the old project will be copied in order to create your new Ruby In 

Steel project. This field is read-only. The target dir ectory must not be the same as the 

source directory.  

 In the third field you may optionally specify one or more extensions of file types which 

should not be imported. The file extensions should be entered following a period and 

separated by semicolons like this: 

  .log;.tmp;.xyz  

 When the 'Exclude hidden files and directories' Check Box is selected, Hidden files and 

hidden directories will not be added to the imported project.  
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 If this is a Ruby On Rails project, be sure to check the 'Rails project?' checkbox. This will 

enable certain Rails-specific features for the imported project such as the One-Click 

Rails Debugger. 

 Before the project is imported, a 'Creation and Import Data' dialog is displayed. This 

shows the following information:  

Total number of files to be copied 

Solution name 

Solution directory 

Import from directory 

Database 

 You should verify that these details are correct. In particular, check the number of files 

which will be copied. If you have selected more files than you actually intended  (by 

accidentally selecting the wrong source directory, perhaps), now is your last chance to 

back out. 

 If all the details are correct, click the Proceed button to begin the import process.  

 

Ruby In Steel will copy the entire directory structure and all the  files it contains to the Target 

location of the new project. Any files which you have specifically excluded will  be copied to 

the target directory but will not be added to the Solution Explorer. 
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Notes on Importing Projects  

 

1) We recommend that you always create a new directory for an imported project. We caution 

against attempting to copy files into a directory which already contains source files. The 

project importer will overwrite any similarly named files and directories in the target 

directory.  

 

2) 3ÏÌɯȿÛÖ×ɯÓÌÝÌÓɀɯËÐÙÌÊÛÖÙàɯÖÍɯàÖÜÙɯÌßÐÚÛÐÕÎɯRails project (that is, the one you import from) will 

ÕÖÙÔÈÓÓàɯÉÌɯÛÏÌɯËÐÙÌÊÛÖÙàɯÞÏÐÊÏɯȿÕÈÔÌÚɀɯÛÏÌɯ×ÙÖÑÌÊÛɯȹÌȭÎȭɯ\Blog ) and which contains various 

subdirectories such as \app, \components , \config  and so on. When making a copy of  a 

project, the Importer copies all the files in a Rails project into the new target directory. It will 

not make any changes to the database or configuration files. 

 

3) If you have created solution files using previous versions of Ruby In Steel, you may find 

that the old solution files do not display correctly in the Solution Explorer. Use the Project 

Importer to convert them for use with the latest version of the software.  

 

4) The Solution Explorer cannot include file (and path) names with certain special-purpose 

names or XML-specific characters such as '&' or single-quotes. The Project importer will copy 

such files to the selected Target directory but will not add them to the Solution Explorer. 

Omitted files will be listed in the General page of the Visual Studio Output window. You may 

view all files (including those excluded from the project, by selecting Project, Show All Files). 
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How To Convert A Project  

 

[Developer Edition Only]  

 
FOLLOW THESE STEPS TO CREATE A VISUAL STUDIO SOLUTION IN THE SAME DIRECTORY AS AN EXISTING 

PROJECT... 

 

When a project is 'converted', existing files and folders are added to the Solution 

Explorer. No modifications are made to the files themselves. The Convert option may 

not be available in some configurations of Visual Studio. In that case, use Import. 

 

 Select the File menu, then Open and Convert... 

 In the Convert dialog, select Ruby Converter Wizard 

 

 

 

 

 Click Create New Solution if you wish to create a Solution specifically for this project. If 

you already have a Solution open in Visual Studio and you wish to add your Ruby 

solution as a Project in that solution, click Add to Current solution. Click OK  
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The Convert Project dialog  appears. Here you must choose the directory containing the Ruby 

(or Rails) files and directories which you wish to convert. You may click the Browse button 

[...] to select a directory. 

 

 

 

 In the second field you should give a name for the converted project. 

 In the third field, you may optionally specify one or more extensions of file types 

which should not be imported. The file extensions should be entered following a 

period and separated by semicolons like this: 

  .log;.tmp;.xyz  

 When the 'Exclude hidden files and directories' checkbox is selected, Hidden files and 

hidden directories will not be added to the imported project.  

 If this is a Ruby On Rails project, make sure the 'Rails project?' checkbox is ticked. This 

ensures you will be able to use Rails-specific features such as the One-Click Rails 

debugger. Leave it unticked for other types of Ruby project.  

 Click OK to convert the project and di splay the files in the Solution Explorer.  
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Using The Solution Explorer  

 

THE SOLUTION EXPLORER IS YOUR CONTROL CENTER FOR RUBY AND RAILS PROJECTS. HERE YOU CAN GROUP 

TOGETHER NUMEROUS RELATED FILES AND FOLDERS AND ADD, REMOVE OR RENAME THEM AS REQUIRED.  

 

TO ADD A N EW PROJECT 

 

Right-click the (top-level) Solution item. Select Add, New Project. Select the Project type from 

the Add New Project Dialog and continue as explained earlier on how to create or import a 

project. 

 

TO ADD A  NEW FILE 

 

Right-click a Project branch (indented beneath the top-level Solution item). Select Add, New 

Item. Now select a file type (Ruby File creates an empty Ruby .rb file ; Empty ERb File creates an 

empty Rails 2 .html.erb  template file;  Empty RHTML  File creates an empty Rails 1 .rhtml  

template file). Various other types of file such as HTML, XML and te xt files can also be 

added. 

 

TO ADD AN EXISTING FILE FROM D ISK 

 

Right-click a Project branch. Select Add, Existing Item. Select a file on disk. Click Add. 

 

TO ADD A  NEW FOLDER  

 

Right-click a Project Branch. Select Add, New Folder. This creates a subdirectory in the Project 

directory.  

 

TO RENAME A FILE OR FOLDER  

 

Select the File or Folder in the Solution Explorer. Press F2. Enter a new name. 
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TO EXCLUDE A  FILE OR FOLDER FROM THE PROJECT 

 

Right-click a File or Folder. Select Exclude From Project. This removes the item or items from 

the project but does not delete them from disk. 

 

TO DELETE A  FILE OR FOLDER  

 

Right-click a File or Folder. Select Delete. Or press the Delete key on your keyboard. 

Caution : Deleting a file or folder from the Solution Exp lorer will also delete the file or 

folder on disk!  

 

DRAG-AND -DROP TO COPY OR MOVE  

 

You may select files or folders and move them to other locations in a solution by dragging 

with the mouse. To copy rather than move files, hold the CTRL key while dragging.  

 

TO SHOW ALL FILES 

 

Normally the Solution Explorer does not display files which are not included in a Ruby or 

Rails project but may, nonetheless, be present on disk (these include the Visual Studio and 

Ruby In Steel solution and project files ɬ the extensions .sln, .suo and .stproj), files with the 

extension .log and files which you have specifically excluded from the project. You can force 

the display of all files in the application directories by selecting Show All Files from the Project 

menu; this also expands all branches of the Solution Explorer. Click the menu item again to 

resume the default view. The Solution Explorer itself also has a small Show All Files button 

(when a project node is selected) beneath its caption bar. 

 
TO SYNCHRONIZE  

 

If files have been added or deleted from a project's directory outside of Visual Studio, the 

display of the files in the project can be brought up to date by clicking the Synchronize button 

beneath the Solution Explorer's caption bar. For more information,  see: Synchronize. 
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TO OPEN A  COMMAND PROMPT IN A  D IRECTORY  

 

With Ruby In Steel there is no need to navigate to a directory from the system prompt. Just 

right -click a file or folder in the Solution Explorer and select Command Prompt from the menu. 

This opens a command window in the selected directory.  
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File Properties  

 

You can select a file in the Solution Explorer and set its properties in the Properties panel. 

These properties can be used to configure certain operations affecting the way in which the 

file will be run or built. The available properties are shown below:  

 

Property  Description  

Arguments  Arguments to pass to your program  

BuildAction  How to build/run this file  

Flags Flags to pass to Ruby.exe such as ɬhelp , -w  or 

--version  

Load Paths Specify $LOAD_PATH; this is a semicolon 

delimited list (equivalent to the ɬI  flag)  

Require Files  a semicolon delimited list of required files 

(equivalent to the ɬr flag) 

Working Directory  The directory in which the Ruby file wi ll run  

 

 
NOTES ON BUILD ACTION : 

 

The default BuildAction for Ruby ( .rb) files is Ruby ; and for a Rails (.html.erb or .rhtml) 

template files it is EmbeddedRuby . For other file types it may be None  or Content . Other 

options may be displayed but currently have no effect and are reserved for future use. You 

may change these build actions as required. These are the build actions available: 

 

Ruby  ɬ checks the Ruby syntax of the file. 

EmbeddedRuby  ɬ processes the file using ERB, the embedded Ruby processor. 

Content/None  ɬ takes no action. 
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Project Properties  

 

A number of settings can be applied to the current project using the Project Properties Pages 

(available from the Project menu).  

 

 

Note : If you do not specify Project properties, the properties of the current project will 

automatically adopt the global options  (available via Tools/Options). When specified, 

however, Project properties take precedence over global properties. In addition, file 

properties (set in the Properties page for a file selected in the Solution Explorer) take 

precedence over Project properties. Not all properties are available in all editions of 

Ruby in Steel.  

 

 

There are two pages of Project Properties: 

 
GENERAL  

 

This page specifies the defaults for the current project. These properties are used with all 

configurations for this project.  

 
BUILD  

 

This page allows you to modify and save named configurations which may be s electively 

loaded in the current project. For example, you might save three named configurations: 

Debug, Test and Release, each of which has different propert ies for items such as the Ruby 

Interpreter, the Ruby Script Arguments or the Rails Server Port. When you wish to switch 

from one configuration to another, you may select the configuration name from the drop -

ËÖÞÕɯȿ2ÖÓÜÛÐÖÕɯ"ÖÕÍÐÎÜÙÈÛÐÖÕÚɀɯlist just beneath the Visual Studio main menu. 
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To Create a New Project Configuration  

 

ü Select Build, Configuration M anager.  

ü Click the Active solution configuration drop -down.  

ü Click <New...> 

ü Enter a name for this configuration.  

ü Click OK.  

ü Click Close. 

 

 

To set Build Properties for a Named Configuration  

 

ü Select Project, Project Properties. 

ü Select the Build tab. 

ü From the Configuration drop -down select a Configuration name. 

ü Change any properties for this configuration and click File, Save All.  
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General Page Project Properties  

 
DEBUGGER 

 Allow Editing While Debugging  

When true allows the code to be edited when debugging. Ot herwise code file is set to 

read-only  

 
AUTOS W INDOW OPTIONS ... 

 

The following options determine which details will be displayed in the Autos window 

when debugging. Be aware that there is a trade-off between completeness and speed. 

When all options are enabled, there may be a noticeable delay in evaluating large data 

structures. This is particularly true in Rails when - for example - the evaluation of self  

may involve huge amounts of data. In general, it is better to use the Watch windows to 

monitor specific  variables. 

 

¡ Autos Window (Class Variables)  

¡ Autos Window (Global Variables)  

¡ Autos Window (Instance Variables)  

¡ Autos Window (Object Methods)  

¡ Autos Window (self)  

¡ Autos Window (Singleton Methods)  

 

 

 

 Enable Just-In-Time Debugging  

When true, an exception will trigger the debugger. 

 F5 Starts Ruby 

When true in a Rails project, F5/CTRL-F5 debug/run current Ruby file. When false, 

they debug/run the Rails application.  

 Keep Stack Frames 

When true, stack frames are stored to allow navigation up and down the stack usin g 

the Call Stack window. When false, debugging is slightly faster but there is no Call -

stack navigation. 

 One Breakpoint Per Line 

When true, a line containing multiple expressions will cause a single step when 

debugging.  

 2ÜÉÚÛÐÛÜÛÌɯȿɤɀɯÍÖÙɯȿ\ ɀ 
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If some breakpoints are not hit, this may be due to inability to match path names due 

ÛÖɯÛÏÌɯÔÐßɯÖÍɯȿɤɀɯÈÕËɯȿ\ ɀɯ×ÈÛÏɯÚÌ×ÈÙÈÛÖÙÚȭɯ3ÜÙÕɯÛÏÐÚɯÖÕɯÛÖɯÍÐßɯÛÏÐÚɯ×ÙÖÉÓÌÔȭɯ-ÖÛÌɯÛÏÈÛɯÛÏÐÚɯ

slows the debugger so should not normally be enabled by default.  

 Use the Cylon Debugger 

When true, the fast Cylon debugger will be used (in those Ruby In Steel editions where 

it is available). When false, the much slower Ruby debugger is used. 

 
RAILS  

 ERb Flags 

Any flags to pass to the ERb (Embedded Ruby) processor. 

 ERb Library Files 

Library files to be used by ERb (a semicolon delimited list).  

 ERb Processor 

The path to the ERb processor (if you wish to override the default).  

 ERb Timeout 

The time in seconds allowed for the ERb processor to complete. 

 Framework  

The Rails framework version (e.g. Rails1 or Rails2). This property determines the 

default extension used for Rails template files. 

 Rails Project 

True for a Ruby On Rails Project. Used for require  files, IntelliSense and debugging. 

 
RUBY  

 Default Ruby Interpreter  

The path to the default Ruby interpreter (e.g. ruby.exe). 

 
SYNCHRONIZATION  

 Exclude Directories 

A line -delimited list of directories to omit when synchronizing.  

 Exclude Extensions 

A semicolon-delimited list of file extensions to omit when synchronizing. e.g.  

.txt; .svn; .log 

 Exclude Files With No Extension 

When True files that have no filename extension are not synchronized. 

 Exclude Hidden Files and Folders 

When True, files and directories with the Hidden attribute set are not synchronized.  
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VISUAL RAILS W ORKBENCH  

 

 Automatically Update Files  

This determines whether changes in the active page design (e.g. changes that affect 

shared layouts and partials) are synchronized in any other open page designs when 

ÊÏÈÕÎÌÚɯÔÈËÌɯÛÖɯÛÏÌɯÈÊÛÐÝÌɯ×ÈÎÌɯËÌÚÐÎÕɯÈÙÌɯȿÊÖÔÔÐÛÛÌËɀɯ- otherw ise they will not be 

synchronized.  

 Design time image path 

The path to which to append non -rooted image files in <IMG> tags at design time. This 

assists in displaying images in a specific path in the page designer.  

 Diff/Merge Tool  

An (optional) difference /merge tool to sue when comparing backup files and archive 

file with the current ERb or page layout document.  

 Diff/Merge Tool Parameters  

Any parameters which you wish to pass to your Difference/Merge tool.  

 Page Design Style 

An optional style block which ca n be used to define design-time styles to help 

highlight the partial ( .erb -partial ) and view ( .erb -view) components of a composite 

page design in the Visual Rails Workbench. For example, the following styles will 

outline a view in a 2 pixel dashed border i n Navy and partials in a 2 pixel dotted 

border in Green: 

<style title="erb -style" type="text/css" xmlns=""><! --   

/* SapphireSteel RWB styles */  

.erb -view{ border: 2px dashed; border -color:Navy; }  

.erb -partial{ border: 2px dotted; border -color:Green; }  

--></style> 
 Use Visual Rails Workbench 

When true, the Visual Rails Workbench integrated environment will be activated when 

you edit Rails template files. When false, a simple ERb editor will be used. 
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Build Page Project Properties  

 
BUILD EVENTS  

 Post-Build Event 

a command to run after the 'build' completes.  

 Pre-Build Event  

a command to run before the 'build' commences. 

 
MISC 

 Working Directory  

The directory in which IRB, Rails, Generate and Rake commands are executed. 

 
RAILS  

 Rails Script 

The Ruby script used to start Rails from within Visual Studio.  

 Rails Server 

The Server to be used when running a Rails application (you must ensure that the 

selected server has been installed).  Selecting an item here will automatically set the 

Rails Script and Web Server Script properties. 

 Rails Server Port 

The port (e.g. 3000) to be used for the Rails server (applied to Mongrel and WEBrick 

only).  

 Web Server Script 

The script used to start the web server. 

 

 

The Rails Server and Scripts . The Rails Server property determines which server Rails 

Server and web Server startup file s to run. For example, selecting WEBrick will cause 

the file webbrick_service.rb  to be selected as the Rails Script and the file 

webbrick_server.bat  as the Web Server Script. If necessary you may edit these files in 

order to change the Ruby script and the path to the server. Note that some startup 

files refer to files located in your Ruby installation and may require specialis t 

knowledge in order to change the default values. The server startup files are located in 

the \scripts  directory beneath your Ruby In Steel Installation.  
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RUBY  

 Ruby Interpreter  

The path to the Ruby interpreter (e.g. ruby.exe). 

 Ruby Interpreter Flags 

Any flags (e.g. -w  or ɬversion) to be passed to the Ruby interpreter. 

 Ruby Library Files  

Library files to be used by Ruby (a semicolon delimited list).  

 Ruby Library Paths 

Paths to library files (a semicolon delimited list).  

 Ruby Script Arguments  

Any arguments to be passed to a Ruby program. 

 Ruby Start File 

The file that Ruby runs (if left blank, Ruby runs the currently active Ruby file).  

 Ruby Type 

Determines which type of Ruby interpreter/compiler is being used when debugging. 

(e.g. Standard Ruby or JRuby). 
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The Editor  

 
THE RUBY IN STEEL EDITOR BUILDS UPON THE EDITING CAPABILITIES OF VISUAL STUDIO AND ADDS 'RUBY 

SPECIFIC' FEATURES... 

 

Overview  

 

The Ruby In Steel editor provides enhanced code-coloring and collapsing for Ruby and Rails 

files plus automated commenting/uncommenting, multi -level undo/redo, drag -and-drop 

copy and paste, code indenting, incremental search with regular expressions, code formatting  

and much more... 

 

Ruby In Steel provides syntax sensitive code coloring and collapsing 

Syntax Coloring  

 Ruby (.rb files)  

Ruby In Steel automatically colors Ruby language elements including keywords, comments 

and data types such as strings, floats and integers and Ruby-specific elements. 

 Rails (.erb and .rhtml files)  

Ruby In Steel colors html elements such as tags, strings and comments. In addition, the 

language elements of embedded Ruby code are also colored. 

 Configure Coloring  

The colors can be altered to taste. Select the Tools menu then Options. In the Options dialog, 

select Fonts and Colors. The Visual Studio colors for elements common to all languages (e.g. 

Keyword or String) are used by Ruby In Steel. There are also some language specific coloring 

options which are preceded by the names Ruby  (e.g. Ruby Brace) or Rails  (e.g. Rails Attribute). 
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Code Collapsing  

  ÜÛÖÔÈÛÐÊɯȿÖÜÛÓÐÕÐÕÎɀɯɤɯÊÖËÌɯɅÍÖÓËÐÕÎɅ 

Ruby In Steel outlines your code so that you can selectively hide code blocks such as classes, 

modules, methods and programming constructs such as if  and while  blocks. In .rhtml  files, 

code collapses on matching tags such as <body></body>. Note that collapsing is dependent 

upon correct syntax. In .rhtml  files, matching pairs of opening and closing tags are required. 

Click the plus (+) or minus ( -) symbols to toggle code collapsing. 

 

Ruby elements which are auto-collapsed include: 

 classes 

 modules 

 methods 

 case statements 

 if  blocks 

 while, unless, until, for  loops 

 =begin/=end comment blocks 

 blocks { and } or do and end delimited  

 

 .×ÛÐÖÕÈÓɯȿÔÈÙÒɯÈÕËɯÊÖÓÓÈ×ÚÌɯÈÙÌÈÚɀ 

(ÍɯÊÖËÌɯÉÓÖÊÒÚɯÈÙÌÕɀÛɯÈÜÛÖÔÈÛÐÊÈÓÓàɯÖÜÛÓÐÕÌËȮɯàÖÜɯÊÈÕɯÔÈÙÒɯÈÕËɯÊÖÓÓÈ×ÚÌɯÈÕàɯÊÖËÌɯàÖÜɯÞÐÚÏɯ

using the ÔÖÜÚÌȭɯ3ÏÐÚɯÓÌÛÚɯàÖÜɯÏÐËÌɯȿÍÙÌÌɯÚÛÈÕËÐÕÎɀɯÊÖËÌɯÈÙÌÈÚɯÖÙɯÊÖÔÔÌÕÛɯÉÓÖÊÒÚȮɯÍÖÙɯ

example. 

 View Tooltip of Collapsed Area  

For a fast view of the hidden text in a collapsed area, hover your mouse over the three dots 

indicating a collapsed area [...]. This will d isplay the hidden code in a tooltip.  

 Collapse To Definitions  

To collapse to all 'top-level' outlines (e.g. all the Class headers in a file containing many 

classes) right-click in the editor and select, Outlining , Collapse To Definitions. 

 Hide Selection  

You can optionally collapse areas which are not normally collapsed (e.g. a comment block). 

Mark the area using the mouse then right-click and select Hide Selection. 

 

Use the other options on the Outlining  menu (right -click in the editor) to toggle the outl ining 

display throughout the current file.  
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Bracket Matching  

 

Ruby In Steel has automatic bracket matching and highlighting. Scroll your cursor over a 

bracket in order to highlight a pair of matching brackets. Press CTRL+] to move the cursor 

quickly from one matching bracket to another. 

 

 

Keyword..end Matching  

 

Many Ruby constructs are delimited by an opening keyword and a closing end ɬ for example: 

class..end, module..end , def..end , while..end  and until..end . You can move your cursor 

between an opening keyword and the matching end using the same key combination used for 

bracket matching: CTRL+]. 

 

   Here we press CTRL+] to toggle between a class definition... 

 

   ...and its matching end keyword. 
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Commenting/ Uncommenting  

 

Mark a block of code and click the Comment button (or press CTRL+E, C) to comment out the 

block. To uncomment a block, click the Uncomment button on the Text Editor Toolbar (or 

press CTRL+E, U). Commented blocks in Ruby source files are marked by inserting comment 

characters # at the start of each line. In Rails template files, HTML comment delimiters are 

used: <!-- and -->. 

 

Smart and Block Indenting  

 

Three code indenting styles are supported. These may be set in the TextEditor/Ruby/Tabs page 

of the Options dialog. They are: 

 

 None  ɬ no automatic indenting.  

 Block  ɬ indent code align with preceding line.  

 Smart ɬ attempt to align by syntax (e.g. align end with matching def ). 

 

Automatic Code Formatting  

 

You can reformat an entire Ruby document or a selected block of code to regularize the 

indenting automatically.  

 
FORMAT DOCUMENT  

The entire contents of a Ruby code file can be auto-formatted by selecting Edit, 

Advanced, Format Document (default shortcut: CTRL+E,D) 

 
FORMAT SELECTION  

The currently selected block of Ruby code can be auto-formatted by selecting Edit, 

Advanced, Format Selection (default shortcut: CTRL+E,F) 

 

Other Features  

 

Ruby In Steel provides the same rich set of editing features available to other Visual Studio 

languages including: Multiple level undo/redo ( CTRL+Z; CTRL+Y), Indent/Outdent, 

bookmarks and macros. 
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Intelligent Coding Tools  

 

[ Most Features Developer edition only]  

 

Ruby In Steel Developer provides a number of coding aids to assist in the writing of code. 

These include a variety of IntelliSense tools such as 'completion lists', 'quick info' and 

'parameter info' as well as in-code syntax error marking ('wavy lines') an d auto-expanding 

Ruby code 'snippets'.  

 

IntelliSense  

 

Ruby in Steel implements the following IntelliSense features for Ruby source files: 

 Member Completion Lists  

 Keyword Completion Lists  

 Variable Completion Lists  

 Quick Info Tooltips  

 Parameter Info Tooltip s 

 Snippets 

 

Member Completion Lists  

 

Member completion lists are drop -down lists showing the available methods, modules and 

classes which may be used after a completion character is entered into the code editor. A 

completion character may be either a single dot ( . )or a double colon ( :: ) as dictated by Ruby 

syntax. Where embedded documentation is provided (in the form of RDoc comments in the 

source code), this documentation is displayed as a tooltip when an item is selected in the 

completion list.   
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Ruby In Steel tries to infer the type and determine the scope of an identifier in order to 

display the appropriate completion list. However, bear in mind that Ruby is a dynamic 

language and the formal types of identifiers are not predeclared so it may often  be impossible 

for Ruby In Steel to 'guess' the type of some variables.  

 

When a specific type cannot be inferred, the completion list defaults to members of the Object 

class. You may, however, specifically assert that a certain type should be assumed in order to 

generate better IntelliSense. Refer to the section on Intelligent Type Inference, at the end of 

this chapter, for more information.  

 

Common and All Tabs  

 

Often the Completion list displays two tabs - Common and All. The Common Tab generally 

ËÐÚ×ÓÈàÚɯÔÌÔÉÌÙÚɯÖÍɯÛÏÌɯÊÜÙÙÌÕÛɯÖÉÑÌÊÛɀÚɯÊÓÈÚÚɯÈÕËɯÈÕàɯÐÔÔÌËÐÈÛÌɯÈÕÊÌÚÛÖÙɯÊÓÈÚÚÌÚȭɯ3ÏÌɯ ÓÓɯ

Tab displays all the members shown in the Common Tab plus the members of the Object 

class. Once you have selected a tab, that tab will remain the default until the other tab is 

selected. 

 

When an object is an instance of Object (or when the IntelliSense is unable to infer any specific 

descendent class for a variable), an untabbed completion list is displayed showing members 

of Object. 

 

Configuring  Completion Lists  

Opt ionally you may turn off the display of Object methods and Ancestor in order to 

restrict the completion lists to the members of more specific classes. The Display Object 

Methods and Display Ancestor Methods option can be set in the Text Editor, Ruby, 

IntelliSense page of the Tools, Options dialog.  
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Keyword Completion Lists  

 

Ruby keywords such as def , while , module  and class may be selected from a completion list. 

This list appears when matching characters are entered if Show completion list after a character is 

typed is selected in the IntelliSense Options (for example, if you enter 'mo ', the completion list 

will highlight ' module ').  You can also force the completion list to appear by pressing 

CTRL+Space. Keywords are displayed in the All  tab. If a keyword match is unambiguous, it 

may also be displayed in the Common tab. 

 

Variable Completion Lists  

 

The completion list will suggest variable names (including local, instance or class variables) 

matching text that has been typed. Force the display of the completion list by pressing 

CTRL+Space. 
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Quick Info Tooltips  

When the source code of a class or method is preceded by a comment block, the comments 

will be displayed in a tooltip when the mouse hovers over a class or method name in the code 

editor. When an object of a known class has been created, its tooltip displays the name of its 

class. Optionally this feature may be disabled by deselecting Display RDOC In Tooltips in the 

Options dialog. Documentation may also be shown in the RDOC Window . 

 

Parameter Info Tooltips  

 

Information on the parameters expected by a method can be displayed in a tooltip when you 

are calling that method. The tooltip is triggered by the opening bracket ( and the highlight 

moves from one parameter to the next as the separating commas are entered. The return type 

of the method is also shown. By default all parameters are shown as instances of the Object 

class. If the return type can be inferred, its class is shown, otherwise NilClass is shown. To 

enable more information in Parameter Info tooltips, see Type Assertions, later in this chapter. 
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Snippets  

 

Snippets are ready-to-use code fragments which can be inserted at the cursor position in the 

code editor by entering a shortcut or selecting a named snippet from a menu. Ruby In Steel 

provides a library of Ruby snippets some of which include interactive fields or 'replacement 

points' into which you can enter specific values such as the names of variables. 

 

TO INSERT A  SNIPPET FROM A  MENU  

 

Right-click at the point in the editor where you would like to insert the s nippet. Click Insert 

Snippet on the shortcut menu. Scroll down to the name of the desired snippet and double -

click it or press TAB to insert the snippet into your code.  

 

 

TO INSERT A  SNIPPET FROM A  SHORTCUT  

 

Snippet shortcuts are short bits of text which are expanded by pressing TAB; they are listed in 

the Code Snippets Manager. For example, if you have a snippet with the shortcut ifelse  you 

could enter the text ifelse  into the code editor and press TAB to auto-expand the snippet. 

Note : in order to enable TAB-expansion of snippets, 'Expand snippets by tab character' must be 

enabled in the Text Editor, Ruby, IntelliSense page of the Options dialog. 

 

 

ADDING CUSTOM DATA TO A  SNIPPET  

 

When inserted into your code, some snippets have one or more highlighted fiel ds 

('replacement points'). If you hover your mouse pointer over a replacement point, a 

descriptive tooltip appears. You may edit a replacement point (say by changing it to the name  

of a particular variable) and, if there are more replacement points, you m ay move directly 

from one to the next by pressing the TAB key. Where multiple replacement points have the 

same name, editing one will automatically change the others to match. 

 

 

 



Ruby In Steel User Guide and Manual  (1.3) ɬ www .sapphiresteel.com ɬ page: 36 

EXPANSION AND SURROUND W ITH SNIPPETS  

 

Most snippets are 'expansion snippets' which means that their text is simply inserted into the 

code editor; if any other text happens to be selected at the time, it will be replaced by the 

expanded snippet. Some snippets are also defined to be 'SurroundsWith' snippets. If you 

select text in the code editor and then insert a SurroundsWith snippet, the snippet text will 

enclose the selected text. For example the if  snippet is a SurroundsWith snippet. Let's assume 

that you have already entered the following in to the code editor: 

 

 puts( 'hello world'  ); 

 

You select this text, then right-click and choose if  from the Snippet menu. When the if  snippet 

is entered it automatically surrounds the selected text, resulting in this:  

 

if  true  then 

 puts( 'hello world'  ); 

end 

 

In this case, 'true'  is a replacement point and it is selected so that you can immediately replace 

it with your desired test condition.  

 

 
SNIPPETS IN THE COMPLETION LIST 

 

You may optionally place snippets into the code completion list. This is the lis t which appears 

when you press CTRL+Space. The list will also appear when you enter text into the code 

editor if the ' Show completion list after a character is typed' option is enabled. The completion list 

options are specified in the Text Editor, Ruby, IntelliSense page of the Options dialog.  

 

 
THE CODE SNIPPETS MANAGER  

 

The Code Snippets Manager is selected from the Tools menu. To view the available Ruby 

snippets, select 'Ruby' in the Language combo and expand the Ruby folder in the left-hand 

pane. Select each snippet to view details such as its shortcut and type ('expansion' or 

'SurroundsWith'). Click the help button (' ?') at the top right of the Code Snippets Manager to 

view its Visual Studio help entry.  
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Snippet Editor  

 

You can create your own snippets using Sniped  ɬ a snippet editor for Ruby . Sniped  is 

supplied with the Developer Edition of Ruby In Steel and comes with its own user guide. The 

snippet editor can be found in the \ Extras subdirectory of your Ruby In Steel installation 

(typically located b eneath C:\ Program Files\ SapphireSteel Software\ ). 

 

Wavy Lines ð Syntax Error Indicators  

 

Syntax errors and warnings are shown in the code editor by a wavy underline marking the 

location at which the error was detected. Note that the line appears only at the point at which 

the syntax becomes unambiguously incorrect. The actual position of the error may sometimes 

lie at a point in the code some way preceding the indicator. You may hover the mouse over a 

wavy line indicator in order to view an explanatory me ssage in a tooltip. 

 

By default a blue wavy line indicates a warning:  

 

 

A red wavy indicates a syntax error:  
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Intelligent Type Inference  

 

Ruby is a dynamic language. Among other things, this means that the types of variables are 

not predeclared and a single variable may have many different types during the lifetime of a 

program. This contrasts with languages such as C and Pascal in which the type of each 

variable is specifically declared and an attempt to assign any other type to that variable is an 

error. 

 

While dynamic typing is useful for some programming tasks, it has the unfortunate side -

effect of making it extremely difficult to provide accurate IntelliSense. Consider the problem: 

in C or Pascal, before you can use a variable x, you have to state its type ɬ say an Array, an 

Integer or a String. Once the type has been declared, the IntelliSense system knows that 

whenever the variable x  is encountered within a specific scope, it can treat it with certainty as 

a variable of the defined type. So if x is a String and the programmer enters x followed by a 

dot then the code-completion list will always display String methods.  

 

Similarly the return type of functions are specifically declared in statically typed languages ɬ 

so if the function someFunction()  is declared to be an Integer, the IntelliSense system knows 

that it can always assume that the value returned by that function is an Integer.  

 

With Ruby, no such assumptions can be made! Neither the variable x, nor the method, 

someMethod() , have predeclared types. It is quite possible for x to be an Array, a String and 

an Integer at various points, and within the same scope, during the execution of a program. 

The method someMethod()  could, equally, have varying return types depending on how that 

method is called. In many cases, this makes it impossible (even in principle) for the 

IntelliSense system to work out exactly which type a variable is or which type a method 

returns ɬ because the method and the variable vary their types at different times during the  

same program when it runs!  

 

The Ruby In Steel IntelliSense system deals with this problem in two ways. In some cases, it is 

possible to infer the type of a variable at a given point in the code. For example, if a String 

such as Ɂ'ÌÓÓÖɯÞÖÙÓËɂ is assigned to x or the method someMethod()  explicitly returns an 

integer then Ruby In Steel will treat x as a string and someMethod()  as an integer. If x is 

subsequently assigned some other type ɬ say an Array ɬ then Ruby In Steel will 

henceforward treat it as an array. These are relatively simple examples of type inference.  
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In fact, Ruby In Steel's intelligent Inference Engine not only infers the type of a variable 

within a given scope; it also infers its type within a given context ɬ that is, it attempts to 

determine which type a variable will have at a certain point when the program is run. This is 

not foolproof, of course; Ruby In Steel analyses the code while it is still being written and the 

actual types of variables may not be certain until the program is run b y the Ruby interpreter. 

Nevertheless, allowing for these constraints, Ruby In Steel constantly analyses your code in 

the background and attempts to determine the most likely types of each variable. So, for 

example, if x is a string on line 1, an Array on l ine 100 and an Integer on line 500, when you 

move to those lines to edit your code, Ruby In Steel attempts to provide the appropriate 

completion lists for the class of x at that given point in the code. The IntelliSense system 

calculates completion lists based on a variety of factors such as inheritance, visibility (public, 

private, class or instance), modularity and inclusion (mixed in modules).  

 

There is currently no way, however, in which the parameters of a method can be reliably 

inferred. If you wish t o have better Parameter Info IntelliSense for methods, you should 

consider using Ruby In Steel's Type Assertions. 

 

 

Type Assertions  

 

Type Assertions are declarations of the expected types of parameters sent to a method and 

the return type of the method. These assertions are entirely optional. They are placed in a 

comment block immediately preceding a method and have no impact upon the meaning of 

the Ruby code itself. In other words, Type Assertions give you extra features when you are 

developing with Ruby  In Steel but they have no effect on the code as far as the Ruby 

interpreter or any other editor or IDE is concerned.  

 

When a method is preceded by type assertions, Ruby In Steel's Parameter Info tooltips are 

able to display information on the asserted par ameter and return types, helping to resolve 

ambiguities and avoid accidental coding errors. Consider, for example, this method:  

 

def  addName( names, aName  ) 

     return  names << aName 

end 
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It is, in principle, impossible to determine the types of the parameters, names and aName, or 

the class of the return value. Even the << is not a sufficient clue as this is defined for many 

different classes in Ruby. Consequently, the addName()  method could legally be called in the 

following ways, in each case both the parameter and the return types being different:  

 

addName( "Fred,Mary," , "Simon" ) 

addName( [ "Fred" ,"Mary" ], "Simon" ) 

addName( [ "Fred" ,"Mary" ], [ "Simon"] )  

addName( 123 , 456  ) 
 

But let's suppose that the programmer who wrote the addNames() method had done so with 

the specific intention that the first parameter, names, should always be an array, the second 

parameter, aName should always be a string and the returned value should always be an 

array.  The programmer could, of course, document this fact somewhere ɬ but there is no 

guarantee that the person calling the method will ever read the documentation. By using 

Type Assertions you can bind your documentation to Ruby In Steel's IntelliSense.  

 

MAKING TYPE ASSERTIONS  

 

Type assertions are entered into a comment block immediately above a method. The assertion 

may include a return type and one or more arguments matching the argument list.   

The syntax for assertions can be summarized like this: 

# :return: => <ReturnType> 

# :arg: <ArgName> => <ArgType> 

# <Optionally More Args... > 

 

Note : When no return type is given, NilClass is assumed. The argument assertions 

should be entered in the same order as the actual parameters. The names of 

arguments used in the assertions will be used by IntelliSense even if those names 

differ from those used in the actual parameter list. If more arguments are asserted 

than actually exist, the superfluous assertions are ignored. If fewer arguments are 

asserted than actually exist, the extra arguments will default to Object when there is a 

return value and to NilClass when there is no return value..  
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Example: 
 

#:return:=>Array  

#:arg:names=>Array  

#:arg:aName=>String  

def  addName( names, aName  ) 

   return  names << aName 

end 
 

Given the assertions above, the parameter info will now show the following:  

 

Automating Type Assertions  

 

You can add a type assertion comment block over a method by entering two # characters on a 

blank line above the method. For example, let's assume you have this method: 

 

def  addName( names, aName  ) 

   return  names << aName 

end 
 

If you enter ## onto the line above this method, Ruby In Steel will automatically insert the 

following  comment block: 

 #:return: => Object 

 #:arg: names => Object 

 #:arg: aName => Object 

You may now edit this to show the desired types. For example: 

 #:return: => Array 

 #:arg: names => Array 

 #:arg: aName => String 

Those types will now be displayed by IntelliSense. 
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The IntelliSense Librarian  

 

The IntelliSense Librarian is an optional tool which pre-compiles selected Ruby files and 

makes their IntelliSense information available to your project. This has three main benefits: 

 

 

¶ (Ûɯ×ÙÖÝÐËÌÚɯÌÕÏÈÕÊÌËɯ1ÈÐÓÚɯ(ÕÛÌÓÓÐ2ÌÕÚÌɯÐÕÊÓÜËÐÕÎɯȿËÈÛÈÉÈÚÌɯ(ÕÛÌÓÓÐ2ÌÕÚÌɀ 

 

Enhanced IntelliSense is automatically provided for Ruby On Rails projects. This includes 

code completion and other IntelliSense features such as documentation tooltips for 

ActiveRecord, ActionController, ActionView and related classes a nd methods. You may also 

generate application -specific database IntelliSense based on the database schema. 

 

 

¶ It makes additional IntelliSense ava ilable to Rails and other web frameworks  

  

When using a frameworks such as Ruby On Rails it is frequently possible to refer to classes 

and methods even though the source files in which those classes and methods are defined are 

ÕÖÛɯ Ú×ÌÊÐÍÐÊÈÓÓàɯ ȿÙÌØÜÐÙÌËɀɯ ÐÕɯ àÖÜÙɯ ÊÖËÌȭɯ 3ÏÐÚɯ ÐÚɯ ÉÌÊÈÜÚÌɯ ÛÏÌɯ ÍÙÈÔÌÞÖÙÒɯ ÙÌÍÌÙÌÕÊÌÚɯ ÛÏÌɯ

necessary files at runtime. The Ruby In Steel IntelliSense engine - in common with the Ruby 

interpreter itself - ÖÕÓàɯÞÖÙÒÚɯÞÐÛÏɯÊÖÔ×ÓÌÛÌɯȿÙÜÕÕÈÉÓÌɀɯ1ÜÉàɯ×ÙÖÎÙÈÔÚȭɯ-ÖÙÔÈÓÓàɯÛÏÐÚɯÔÌÈÕÚɯ

that IntelliSense is only provided for classes in the current file or any classes that are required 

or included in accordan ce with Ruby syntax. However, you can bypass this limitation by 

creating precompiled libraries of any additional files required by Rails or another framework. 

When you add the library files to the Solution Explorer, your code will have access to all the 

reÓÌÝÈÕÛɯ(ÕÛÌÓÓÐ2ÌÕÚÌɯÐÕÍÖÙÔÈÛÐÖÕɯÑÜÚÛɯÈÚɯÛÏÖÜÎÏɯÛÏÌàɯÏÈËɯÉÌÌÕɯȿÙÌØÜÐÙÌËɀɯÌß×ÓÐÊÐÛÓàɯÐÕɯàÖÜÙɯ

Ruby code. 

 

 

¶ It increases the speed of parsing large source code libraries  

 

Some Ruby libraries (for example, date or yaml ) are very large and complex and some 

li braries may also ȿÙÌØÜÐÙÌɀɯÔÈÕàɯÖÛÏÌÙɯ1ÜÉàɯÍÐÓÌÚȭɯ ÚɯÛÏÌɯ1ÜÉàɯ(Õɯ2ÛÌÌÓɯ(ÕÛÌÓÓÐ2ÌÕÚÌɯÌÕÎÐÕÌɯ

interprets  and analyses source code in order to provide accurate code completion, the 

analysis of very complex source code files may have an adverse effect upon the speed of code 

completion. In most cases, you will not alter the code in these required libraries, so it would 

be more efficient  if the IntelliSense engine did not constantly reanalyze the source code. When 

you compile the code into a library, the IntelliSe nse engine will obtain information from the 

library instead of analyzing  the Ruby source code, resulting  in a speed improvement.  
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NOTE : Many Ruby programmers may never need to use the IntelliSense Librarian. 

For most ordinary Ruby programs, our automatic  IntelliSense engine will provide the 

full range of code completion  features almost instantly. You only  need to use the 

Librarian if you need the additional capabilities described above. 

 

 
CREATING A  NEW INTELLI SENSE LIBRARY  

 

The following provides a simple example of using the Librarian to generate an IntelliSense 

Library  from some Ruby source files and automatically  add that Library to the currently 

loaded project. 

 

 

ü Click  the Librarian menu item on the Ruby menu or Ruby toolbar . 

ü This loads the Librarian . 

ü Click Files/Add Files . 

ü In the Open dialog, select one or more souÙÊÌɯÊÖËÌɯÍÐÓÌÚɯÈÕËɯÊÓÐÊÒɯȿ.×ÌÕɀ. 

ü Your selected files will now be added ÛÖɯÛÏÌɯȿ ÝÈÐÓÈÉÓÌɯ%ÐÓÌÚɀɯÓÐÚÛ. 

ü "ÓÐÊÒɯÛÏÌɯȿ ËËɯ ÓÓɀɯȹÙÐÎÏÛ-facing double arrow) but ton to add all available fil es to the 

ȿ2ÌÓÌÊÛÌËɯ%ÐÓÌÚɀɯÓÐÚÛ. 

ü $ÕÚÜÙÌɯÛÏÌɯȿ ËËɯÎÌÕÌÙÈÛÌËɯlibrary  ÛÖɯ×ÙÖÑÌÊÛɀɯoption  is checked. 

ü Click the Generate button.  

ü When prompted , enter a file name, without an extension - such as mylib. Then click 

ȿ2ÈÝÌɀ. 

ü The compiler will now generate an IntelliSense library based on the selected source 

files. After a short while ( depending  on the size and complexity of the library), a dialog 

will  inform you that the Library gen ÌÙÈÛÐÖÕɯÐÚɯÊÖÔ×ÓÌÛÌȭɯ"ÓÐÊÒɯȿ.*ɀȭ 

ü "ÓÐÊÒɯȿ$ßÐÛɀɯto close the Librarian. You will now see your Library  beneath the Solution 

$ß×ÓÖÙÌÙɯȿ1ÌÍÌÙÌÕÊÌÚɀɯÕÖËÌɯÐÕɯyour Project. 

ü The IntelliSense information is now available for use in your  project even to those 

ÚÖÜÙÊÌɯÍÐÓÌÚɯÞÏÐÊÏɯËÖɯÕÖÛɯÌß×ÓÐÊÐÛÓàɯȿÙÌØÜÐÙÌɀɯthe original Ruby code files. 
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Librarian Reference  

 

Once you have started the Librarian  by clicking the Librarian icon you will see this dialog : 

 

 
The IntelliSense Librarian 

 
THE FILES MENU  

 

The Files menu has the following items... 

 
ü ADD D IRECTORY  

This opens a dialog from which you may select a directory. All the Ruby source files in the 

selected directory will be added to the IntelliSense library. Subdirectories are not added. 

'ÖÞÌÝÌÙȮɯÍÐÓÌÚɯÛÏÈÛɯÈÙÌɯȿÙÌØÜÐÙÌËɀɯÐÕɯÛÏÌɯÚÖÜÙÊÌɯÍÐÓÌÚɯÞÐÓÓɯÉÌɯÈËËÌËɯeven if the required files 

are in different directoriesȭɯ"ÓÐÊÒɯȿ.*ɀɯÛÖɯÚÈÝÌɯÈÓÓɯÛÏÌɯÚÖÜÙÊÌɯÍÐÓÌÚɯÍÙÖÔɯÛÏÌɯÚÌÓÌÊÛÌËɯËÐÙÌÊÛÖÙàɯ

ÐÕÛÖɯÛÏÌɯ+ÐÉÙÈÙÐÈÕɀÚɯȿ ÝÈÐÓÈÉÓÌɯ%ÐÓÌÚɀɯÓÐÚÛȭ 

 
ü ADD FILES 

This opens a dialog from which you may select one or more Ruby source files. In this dialog, 

àÖÜɯÔÈàɯ×ÙÌÚÚɯ2ÏÐÍÛɯÞÏÌÕɯÊÓÐÊÒÐÕÎɯÛÏÌɯÔÖÜÚÌɯÐÕɯÖÙËÌÙɯÛÖɯÚÌÓÌÊÛɯÔÜÓÛÐ×ÓÌɯÍÐÓÌÚȭɯ"ÓÐÊÒɯȿ.×ÌÕɀɯÛÖɯ

ÚÈÝÌɯÛÏÌɯÚÌÓÌÊÛÌËɯÍÐÓÌÚɯÐÕÛÖɯÛÏÌɯ+ÐÉÙÈÙÐÈÕɀÚɯȿ ÝÈÐÓÈÉÓÌɯ%ÐÓÌÚɀɯÓÐÚÛȭɯ 
 

ü CLEAR 

3ÏÐÚɯËÌÓÌÛÌÚɯÈÓÓɯÍÐÓÌÚɯÍÙÖÔɯÛÏÌɯȿ ÝÈÐÓÈÉÓÌɯ%ÐÓÌÚɀɯÓÐÚÛȭɯ3ÏÐÚɯÏÈÚɯno effect on the original files 

stored on disk. 
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THE RAILS  MENU  

 

This menu is only available when the current project is a Rails project. This should be set by 

default  for rails projects and can also be selectively enabled by Project/Properties. The Rails 

menu has the following items ... 

 
ü BUILD RAILS LIBRARY  

 

Ruby In Steel auto-generates a pre-compiled Rails IntelliSense library and you should not 

normally need to use this option unless you install a significantly new version of Rails which 

requires additional IntelliSense . When you use this, you may need to browse to the 

directories containing the relevant Rails source code. The Rails directories are normally 

located beneath your Ruby\ gems directory. 

 

   For example: c:\ ruby\ lib\ ruby\ gems\ 1.8\ gems\  

 

You may need to browse to specific directories. 

 

    For example: c:\ ruby\ lib\ ruby\ gems\ 1.8\ gems\ activerecord-2.0.2\ lib\ active_record\   

 

The relevant Rails directories are shown below - here, we substitute <Ruby\ Gems> for the 

actual Ruby\ gems path on your system. The version numbers of the directories (here 2.0.2) 

w ill vary according to the installed version of Rails : 

 

Active Record:   <Ruby\ Gems> \ activerecord-2.0.2\ lib \ active_record\  

Action Controller:    <Ruby\ Gems> \ actionpack-2.0.2\ lib \ action_controller \  

Action View:   <Ruby\ Gems> \ actionpack-2.0.2\ lib \ action_view\ helpers\  

Unit Test:    <Ruby\ Gems> \ activerecord-1.15.3\ lib \ active_record\  

 

You may select or deselect Rails generator options by clicking the check boxes alongside each. 

 

Please note: Rails IntelliSense generation is a very time-consuming process which 

may take 15 minutes or longer. Visual Studio will not be available for use during this 

time. Please wait. Do not shut down Visual Studio until the Rails IntelliSense generation has 

completed. A progress bar shown at the bottom of the Visual Studio environme nt 

indicates the approximate time to completion. At the end of the process you will see a 

dialog informing you that the Rails IntelliSense Library  was built successfully. 
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ü DATABASE INTELLI SENSE 

 

Database IntelliSense is designed to provide code completion within Rails views (inside 

embedded Ruby templates such as new.html.erb) and is generated from the database schema 

files which are created when you perform Rails migrations. A  s chema file is normally found 

in the Rails \ db directory.  Note that if your schema is not visible, you may need to 

synchronize the Solution Explorer ( Ruby/Synchronize). 

 
TO CREATE DATABASE INTELLI SENSE: 

 

ü Select the schema file (normally schema.rb) when prompted  ÈÕËɯÊÓÐÊÒɯȿ.×ÌÕɀȭɯɯ 

ü "ÓÐÊÒɯȿ.*ɀɯÞÏÌÕ asked to confirm that you wish to build the database schema.  

 
 

THE BUTTONS  

 

 
ü RIGH T ARROW   

Add highlighted file in the Available  Files list to the Selected files list. 
ü LEFT ARROW  

Remove the highlighted in the Selected Files list file from the Selected files list. 
ü DOUBLE -RIGHT ARROW  

Add all files in the Available  Files list to the Selected files list. 
ü DOUBLE -LEFT ARROW  

Remove all files from the Selected files list. 

 

 
ü GENERATE  

 

3ÏÐÚɯÊÖÔ×ÐÓÌÚɯÈÕɯ(ÕÛÌÓÓÐ2ÌÕÚÌɯÓÐÉÙÈÙàɯȹÈɯȿsymbol ÛÈÉÓÌɀȺɯÜÚÐÕÎɯÐÕÍÖÙÔÈÛÐÖÕɯfrom the files in the 

2ÌÓÌÊÛÌËɯ%ÐÓÌÚɯÓÐÚÛȭɯ6ÏÌÕɯàÖÜɯÚÌÓÌÊÛɯȿ&ÌÕÌÙÈÛÌɀɯÈɯËÐÈÓÖÎɯÞÐÓÓɯ×ÙÖÔ×ÛɯàÖÜɯÍÖÙɯÈɯÍÐÓÌɯÕÈÔÌȭɯ8ÖÜɯ

ÚÏÖÜÓËɯÌÕÛÌÙɯÈɯËÌÚÊÙÐ×ÛÐÝÌɯÍÐÓÌɯÕÈÔÌɯȹÞÐÛÏÖÜÛɯÈÕɯÌßÛÌÕÚÐÖÕȺɯÚÜÊÏɯÈÚɯȿmynÜÔÌÙÐÊÓÐÉɀ.  The 

ÌßÛÌÕÚÐÖÕɯȿ.rstɀɯ(Ruby Symbol Table) will be added automatically . You may save the library 

into any directory but we recommend ÜÚÐÕÎɯÛÏÌɯËÌÍÈÜÓÛɯȿ\ 2àÔÉÖÓ3ÈÉÓÌÚɀ subdirectory which is 

stored beneath your \ AppData\ Local folder. 

 

Note : If you wish to add the generated library to the current project (this is the 

ËÌÍÈÜÓÛȺȮɯÔÈÒÌɯÚÜÙÌɯÛÏÈÛɯÛÏÌɯȿ ËËɯÎÌÕÌÙÈÛÌËɯÓÐÉÙÈÙàɀɯÖ×ÛÐÖÕɯÐÚɯÚÌÓÌÊÛÌËȭ 
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Example: 

 

+ÌÛɀÚɯÈÚÚÜÔÌɯÛÏÈÛɯàÖÜÙɯschema.rb contains this code: 

 

create_table "posts", :force => true do |t|  

    t.string   "title"  

    t.text     "body"  

    t.datetime "created_at"  

    t.datetime "updated_at"  

end 

 

Now in your Posts controller, ( posts_controller.rbȺȮɯ ÓÌÛɀÚɯ ÈÚÚÜÔÌɯ àÖÜɯ ÏÈÝÌɯ ÛÏÌɯ ÍÖÓÓÖÞÐÕÎɯ

method: 

 

def show  

    @post = Post.find(params[:id])  

   # etcetera...  

end 

 

With database IntelliSense you can now enter a dot after the variable, @post, and you will see 

ÔÌÛÏÖËÚɯËÌÍÐÕÌËɯÍÖÙɯÛÏÌɯËÈÛÈÉÈÚÌɯÊÖÓÜÔÕÚɯÓÐÚÛÌËɯÐÕɯÛÏÌɯȿ"ÖÔÔÖÕɀɯ×ÈÎÌ. These database 

ÔÌÛÏÖËÚɯÞÐÓÓɯÈÓÚÖɯÉÌɯÈÝÈÐÓÈÉÓÌɯÐÕɯÛÏÌɯȿ ÓÓɀɯ×ÈÎÌɯÈÓÖÕÎɯÞÐÛÏɯÔÈÕàɯÖÛÏÌÙɯÔÌÛÏÖds for a Post 

object... 

 

 
 

Database IntelliSense is also available for the instance variable matching the controller name 

(e.g. @post) when you are writing code in a view   (e.g. \ posts\ show.html.rb) between 

embedded Ruby tags (<% and %> or <%= and %>). 
 

 
ü EXIT  

The Exit button closes the Librarian.  
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To Add Libraries to A Project  

 

(ÍɯàÖÜɯÏÈÝÌɯ×ÙÌÝÐÖÜÚÓàɯÊÙÌÈÛÌËɯÈɯ+ÐÉÙÈÙàɯÍÐÓÌɯȹÈɯȿ1ÜÉàɯ2àÔÉÖÓɯ3ÈÉÓÌɀɯÞÐÛÏɯÛÏÌɯÌßÛÌÕÚÐÖÕɯȭrst) 

which you wish to use in the current project, follow these steps:  

 

ü In The Solution Explorer, righ t-click the References ÕÖËÌɯÈÕËɯÚÌÓÌÊÛɯȿ ËËɯ1ÌÍÌÙÌÕÊÌɀȭ 

ü Select the Browse tab and either select one of the listed .rst files or, if necessary, 

browse to the directory containing  it (the default is \ AppData\ Local\ SapphireSteel 

Software\ SymbolTables).  

ü Select the library (.rst) file(s) and click the Add button.   

ü When all the desired library files have been added, click OK.  

ü The libraries should now be listed beneath the References branch of the Solution 

Explorer. 
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Code Navigation  

[ Some Features Developer Edition only ]  

 

Ruby In Steel has a variety of tools to help you find the code you are looking for.  

 

 Navigation Bars let you locate classes and methods in the current document 

 Go To Definition helps you find the definition of variables, methods and classes  

 Bookmarks can mark places in code so that you can navigate back to them quickly 

 Find and Replace tools let you search through one file or an entire project 

 The Ruby Explorer locates code and documentation of classes and methods 

 

Navigation Bars  

 

At the top of the code editor window you will see a navigation bar containing two drop -

down combo boxes. 

 

 

The box on the left-hand side lists any classes and modules in the current code file. The box to 

its right lists methods, constants and variables. You can select an item from either of these 

combo boxes in order to locate its definition in the code editor.  

 

Go To Definition  

 

Right-click the name of a method, class or variable in your code and select Go To Definition 

from a popup menu in order to locate the definition of the selected item. If the definition is in 

a required file or a Ruby Class Library file, the file will be automatically loaded into the 

editor. If the definition is in one of the C -language files of the Ruby class library, a Ruby 

documentation file containing the embedded documentation and empty Ruby -syntax 

declarations ('stubs') of the original C-language classes and libraries will be loaded. 
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Bookmarks  

 

You can place bookmarks at specific locations in your code in order to be able to return to 

those locations quickly. Bookmarks can be managed using the Bookmarks Window (available 

from the Views, Other Windows menu) or from the Text Editor Toolbar. Bookmar ks are 

documented in more detail in the main Visual Studio help system.  

 

Find and Replace  

 

Ruby In Steel supports all the default Visual Studio Search tools to let you find and replace 

text in the current document or in multiple files. Optionally you can s earch with wildcards 

and regular expressions. Searching tools are available from the Edit, Find and Replace 

submenu. 

 

Incremental Search  

 

You can search incrementally in the current document by entering a sequence of characters. A 

highlight will move throu gh the code to find the first occurrence of matching text (if any). 

Incremental Searching is available on the Advanced,Edit submenu (shortcut: CTRL+I ). 

 

Go To Line  

 

You can move your cursor to a specific line number using the Go To dialog (shortcut: 

CTRL+G) from the Edit menu.  
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The Ruby Explorer  

 

 

The Ruby Explorer is a class browsing tool which can be used to view an alphabetical outline 

of Ruby classes and methods. The Explorer shows the classes of the standard Ruby library 

plus the classes defined in the current project. The methods of each class can be viewed by 

clicking the + symbol to the left of the class name.  

 

You can double-click a class or method name in order to navigate to its source code (if 

available) and any embedded documentation. Much of Ruby's class Library is written in the 

C language; in these cases, the Ruby Explorer will load up a Ruby documentation file which 

has been generated from the original C file and it will navigate to the documentation relating 

to the selected class or method. 
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The Debugger  

 
RUBY IN STEEL INCLUDES INTEGRATED DEBUGGING TO HELP TO FIND AND FIX ERRORS IN RUBY AND RAILS 

APPLICATIONS. THESE ARE THE ESSENTIAL FEATURES OF THE DEBUGGER... 

 

 

Ruby In Steel Developer uses our fast 'Cylon' Debugger by default; the slower Ruby 

Debugger is provided with the Text Edition .  Not all debugging operations are 

available in the Text Edition Debugger.  

 

 

Breakpoints  

 

Ruby In Steel lets you add breakpoints to your Ruby programs by clicking in the margin of 

selected code lines. You can selectively enable/disable selected (or all) breakpoints in this 

breakpoints window. You can also remove an existing breakpoint by clicking it in the margin 

of the code editor. 

 

Note : Once a breakpoint has been added, you may right-click it (in the margin) in order to set 

a number of condition s as explained in the following pages ...  
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Break On Hitcount  

 

 
To break after a specific piece of code has executed a certain number of times, add a 

Breakpoint Hit counter. Do this by right -clicking the breakpoint and selecting a condition such 

ÈÚɯȿbreak when hitcount is multiple ofɀɯfrom the drop -down list. Add the integer value to test. 

 

Conditional Breakpoints  

 

 
 

If you only want to break when a condition (a test of one or more values) is met, create a 

Conditional Breakpoint. This can be entered in normal Ruby syntax. 



Ruby In Steel User Guide and Manual  (1.3) ɬ www .sapphiresteel.com ɬ page: 54 

Run Macro On Break  

 

 
 

You can attach a macro to a Breakpoint - for example, you could write or record a macro to do 

anything from popping up a dialog box to inserting comments into your code - and this will 

run when the breakpoint is hit.  

 

Tracepoints  

 

 
 

(ÍɯàÖÜɯÞÐÚÏɯÛÖɯÉÌɯÈÓÌÙÛÌËɯÛÏÈÛɯÈɯ×ÐÌÊÌɯÖÍɯÊÖËÌɯÏÈÚɯÌßÌÊÜÛÌËɯÉÜÛɯàÖÜɯËÖÕɀÛɯÞÈÕÛɯÌßÌÊÜÛÐÖÕɯÛÖɯ

break you should add a Tracepoint. When a Tracepoint is hit it will print the specified 

message to the Output window wi thout causing the program to stop.   

 

Tracepoints are set by right-clicking a breakpoÐÕÛɯÈÕËɯÚÌÓÌÊÛÐÕÎɯÛÏÌɯȿ/ÙÐÕÛɯÈɯÔÌÚÚÈÎÌɀɯÖ×ÛÐÖÕɯÐÕɯ

the dialog. You may place the names of variables between curly brackets ( for example, 

@xxx ) in order to display their cur rent values. The keyword $FUNCTION  displ ays the 

name of the currently executing method.  
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Break On Exception  

 

 
 

If Just-in-time Debugging is enabled (Tools, Options, Projects and Solutions, Ruby In Steel), a 

debugging session will break when an exception occurs. When this happens you can examine 

the state of the program using the usual range of debugging windows.  

 

 

Locals window  

 

The Locals window automatically monitors and displays the values and types of local 

variables and you can 'open up' items such as arrays and hashes in order to drill-down into 

variables. 
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Autos Window  

 

 

The Autos Window optionally displays the values and types of global, class and instance 

variables, object methods and singleton methods available, plus self . The information 

displayed may be configured globally for all new projects ( Tools, Options, Projects and Settings, 

Ruby In Steel) or for just the current project (Project, Properties). Note that some projects may 

require the evaluation of large amounts of data - particular ly for  self . If debugging seems 

slow, you may want to experiment with the settings for this window.  

 

Watch Window  

 

 

You can enter the names of variables (or drag and drop variables from the editor window) in 

the Watch window. Ruby In Steel Developer lets you 'drill -down' into watch variables to 

view finer levels of detail. For example, you can open up Arrays and Hashes to view the 

objects they contain. To drill -down, click the + symbol to the left of each variable to open up 

sub-branches of information.  
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Quick Watch Window  

 

 
 

The Quick watch window (available on the main Debug menu) is a convenient place for trying 

out expressions. Here, for example, you might ask Ruby to evaluate an expression such as the 

following:  

 

  [1,2,3,[4,5,6]].flatten.reverse  
 

3ÏÌɯÙÌÚÜÓÛɯȹÛÏÌɯÛÞÖɯÈÙÙÈàÚɯÔÌÙÎÌËɯÐÕÛÖɯÖÕÌɯÈÕËɯÙÌÝÌÙÚÌËȺɯÊÈÕɯÉÌɯÐÕÚ×ÌÊÛÌËɯÐÕɯÈɯȿËÙÐÓÓɯËÖÞÕɀɯ

Quick Watch viewer. If you want to place a permanent watch on a variable or expression, 

ÊÓÐÊÒɯÛÏÌɯȿ ËËɯ6ÈÛÊÏɀɯÉÜÛÛÖÕɯÛÖɯ×ÓÈÊÌɯÐÛɯÐÕÛÖɯÈɯËÖÊÒÌËɯ6ÈÛÊÏɯÞÐÕËÖÞȭ 
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Immedi ate Window  

 
 

The Immediate Windows is useful for trying out bits of code when stopped at a breakpoint. 

Here you can evaluate simple expressions such as: 

 

1 + 2 
 

And you can enter assignments such as: 

 

myarray  = [1,2,3,[4,5,6,[7,8,9]]]  
 

You can also evaluate expressions such as: 

  

newarray = myarray.reverse  
 

The Immediate window has no convenient way of displaying complex data structures, so an 

array, for example, will be shown simply as [..] . However, when you evaluate local variables 

these will auto matically be shown in the Locals window. Alternatively you can hover over a 

variable name in the Immediate window in order to drill down into it.  

 

The Immediate window includes the ability to copy and paste text and you can press the up 

and down arrow keys  to scroll back and forth through the sequence of previously entered 

expressions.  
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Dynamic Debugging  

 

When stopped at a breakpoint Cylon lets you edit the values of variables in debug windows 

such as Watch and Locals. Select a variable and click to put it into Edit mode...  

 

 
You can even change the type of a variable in this way. Here the Fixnum, x , is selected and 

the variable is now being assigning a Treasure object, t1 ... 

 

 
 

Now, x  has been assigned t1  and its class type is now Treasure rather than Fixnum ... 
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Evaluate Expressions In The Ruby Console  

 

When stopped at a breakpoint, you may evaluate expressions or you may call Ruby methods 

in the Ruby Console. To evaluate a variable, simply enter its name. 

 

 

Hover and Drill -Down In The Ruby Console  

 

 

When you have stopped at a breakpoint, you can enter the name of a variable into the 

editable part of the integrated Ruby console. Hover the mouse over the variable name to view 

drill -down details of that variable.  
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Hover and Drill -Down in the Ruby Edi tor  

 

 

When paused at a breakpoint, you can hover the mouse over a variable name in the code 

editor in order to display drill -down details of that variable.  

 

Tracing with Step Into / Step Over / Step Out  

 

 

When you hit a breakpoint, press F10 to continue tracing through the current block of code 

(Step Over) or F11 to trace into any methods called by the current code (Step Into) or 

SHIFT+F11 (Step Out) to step out of the current method and continue from the next line of the 

calling routine. These commands are also available on the Debug menu. 

 

Run To Cursor  

 

Right-ÊÓÐÊÒɯÈɯÓÐÕÌɯÖÍɯÚÖÜÙÊÌɯÊÖËÌɯÈÕËɯÚÌÓÌÊÛɯȿ1ÜÕɯ3Öɯ"ÜÙÚÖÙɀɯÍÙÖÔɯÛÏÌɯ×Ö×Ü×ɯÔÌÕÜȭɯ8ÖÜÙɯ

program will pause on the selected line and you can then use the debugging features (trace, 

watch etc.)  
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Call Sta ck 

 

When your code is running several methods deep you can see this in the Call Stack pane. 

Double-click items to navigate through the stack. (Call stack navigation available in 

Developer  Edition only ). 
 

HOW TO USE THE CALL STACK  

 

(ÕɯÌÍÍÌÊÛȮɯÛÏÌɯ"ÈÓÓɯ2ÛÈÊÒɯÓÌÛÚɯàÖÜɯȿÛÙÈÊÌɯÉÈÊÒÞÈÙËÚɀɯÛÏÙÖÜÎÏɯÛÏÌɯÌßÌÊÜÛÐÖÕɯÖÍɯàÖÜÙɯ1ÜÉàɯ

programs. Each time you step into a new method with the debugger, a new entry is added to 

the call stack. So, if you enter method x, the call stack shows x along with (optionally) some 

other information such as the name of the source file and the line number. (Right click the 

Call Stack window and select options from a popup menu to configure the visible details). If 

some code in the x method calls the y method, the call stack will show entries for x and for y. 

These are not just static indicators of the methods which your program has passed through; 

ÛÏÌàɯÈÙÌɯÈÊÛÐÝÌɯȿÔÖÔÌÕÛÚɀɯÐÕɯÛÏÌɯÍÓÖÞɯÖÍɯÌßÌÊÜÛÐÖÕɯÞÏÐÊÏɯÊÈÕɯÉÌɯÙÌÊÈÓÓÌËɯÑÜÚÛɯÉàɯÊÓÐÊÒÐÕÎɯÌÈÊÏɯ

entry in the call stack. 

 

So if, for example, you have a parameter called aString  ÞÏÐÊÏɯÏÈÚɯÛÏÌɯÝÈÓÜÌɯɁÏÌÓÓÖɯÞÖÙÓËɂɯ

when it is passed to xȰɯÏÈÚɯÉÌÌÕɯÊÏÈÕÎÌËɯÛÖɯɁ'$++.ɯ6.1+#ɂɯÉàɯÛÏÌɯÛÐÔÌɯÐÛɯÐÚɯ×ÈÚÚÌËɯÛÖɯy 

ÈÕËɯÏÈÚɯÉÌÊÖÔÌɯɁ#+1.6ɯ.++$'ɂɯÞÏÌÕɯÐÛɯÈÙÙÐÝÌÚɯÈÛɯz, you can flip up and down the call 

stack, recalling each point of execution and view the changing values of aString at each point. 

 

Tip : View the changing values of variables in the Watch or Local window as you 

navigate the Call Stack. 

 

This even works with recursive metho ds. If a method calc increments a variable sum as it 

repeatedly calls itself, you can navigate up and down each separate instant at which the calc 

method was recursively called to check on the changing value of sum. 

 
STOP DEBUGGING  

 

Press SHIFT+F5 to stop debugging.  
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Run, Debug, Build  

 

Run 

 

A) IN THE RUBY CONSOLE  

To run a program without debugging inside the Visual Studio environment...  

Press CTRL+F5 or CTRL+2. 

Or select Ruby menu, Ruby Run. 

Or select Debug menu, Start without debugging. 

You can now interact with the program within the Ruby Console (if this is not visible, select 

the View menu, then Other Windows and Ruby Console).  

 

The Ruby Console may either be placed in its own tabbed page or it may be docked or 

'floated'. You can change its tabbed, docked or floating behavior by right -clicking its 

caption bar and making a selection from a popup menu.  

 
B) IN A  COMMAND W INDOW  

To run  a program without debugging inside a popup 'command window'...  

Press CTRL+1. 

Or select Ruby menu, Ruby command. 

Debug 

To run a program with debugging...  press F5 

Or select Debug menu, Start Debugging. 

 

Build To Check For Syntax Errors  

 

Build Solution  and Rebuild Solution  examine the files in a project and report on any syntax 

errors.  Unlike the Build option for compiled la nguages, Ruby In Steel's Build/Rebuild does not 

create an executable file.  

 To Build  a Solution, select Build, Build Solution. 

 To Rebuild  a Solution, select Build, Rebuild Solution. 

You can view the progress of the error checking in the Output window. Er rors are reported in 

the Error List. Build  only checks those files which failed a previous Build or have been 

changed since a previous Build; Rebuild  checks all files.  
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As part of the Build process, Steel creates a \ SyntaxCheck directory containing a reco rd of all 

the documents built (these are 0-length files). If you wish, you can remove this directory by 

selecting Clean Solution from the Build menu. Once this is done, the next time you perform a 

Build, all the files in the solution will be checked (that is, Build will perform the same action 

as Rebuild). 

 

Setting The BuildAction Property  

 

 

Build and Rebuild only check those files with a BuildAction property. The 

BuildAction of Ruby ( .rb) files is, by default, Ruby ; the BuildAction of Rails ( .rhtml) 

files defaults to EmbeddedRuby . If you want to exclude a file from the syntax 

checking performed by Build, select that file in the Solution Explorer and, in the 

Properties window, change its BuildAction property to None . 
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Compile  

 

The Compile option on the Build menu (CTRL+F7) is used to recompile the IntelliSense 

database. If, for any reason, the IntelliSense is not up to date with your changes, you may 

select this to force a re-parse of IntelliSense data. Note: IntelliSense requires syntactically correct 

code. If any syntax errors are flagged, you should correct these before selecting the Compile option. 

 

Error List  

 

 

The Error List window shows message on a separate row; it displays the name of the file in 

which the problem occurs and the l ine on which Ruby believes a syntax error to be found. 

Click the item to locate the problem line of code. 

 

There are three types of message which may be displayed in this window: Error, Warning 

and Message. You can toggle the display of these messages by selecting the appropriate tabs. 

In the code editor, the location of an error is indicated by a red wavy line; the location of a 

warning is indicated by a blue wavy line.  
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Ruby and Rails Tools  

 
A SET OF TOOLS AND DIALOGS IS AVAILABLE ON THE RUBY MENU AND TOOLBAR. THIS IS A GUIDE TO THEIR 

PRINCIPAL FEATURES... 

The Ruby Toolbar and Menu  

(some items only in Developer Edition)  

 

The Ruby menu and Toolbar provide access to a number of tools for use with Ruby and Rails. 

 

 
The Ruby Menu 

 

 
The Ruby Toolbar 

THE RUBY TOOLS  

 

 Ruby Run  ɬ runs the currently active file in a docked window  

 Ruby Command  - runs the currently active file in a system ('command') window  

 IRB  ɬ runs the Interactive Ruby shell  

 One-Click Rails Debugger  ɬ starts debugging a Rails project 

 Start Server  ɬ  starts a server (for Rails) 

 Rake ɬ displays a toolwindow to run Rake  

 Gems ɬ loads a dialog to install a Gem package 

 Generate ɬ displays a toolwindow to run Rails generate scripts  


